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ffice 2007 comes with many new features and a significant change to the user interface.  As a 
long time user of Word, PowerPoint, Excel or other Office Applications, you may want an 
overview of what to expect as you begin your navigation of the new look and feel that 

Microsoft has released.   Although most of the standard ways that you use each application will not 
change, there are a few characteristics that you will want to be aware of before you get started. 

The User Interface of Office 2007 
Microsoft listened to the critics who complained about Word’s maze of menus and dialog boxes.  Other 
complaints were about the illogically placed commands and important tools that were buried.  With the 
new Word 2007, all commands have been reorganized according to task and function.  Therefore, some 
of your old favorite’s ― like Cut and Paste are in new places.  And some features like mail merge and 
indexing have evolved ― and are out in the open and easier to use. 

Microsoft’s second concern was security.  They have made major changes in Word’s file formats to 
minimize opening documents that may contain viruses.   

  The overall consensus is that newer users will love the ease of finding commands, and more expert 
users will find themselves making more clicks to perform the same old tasks.   Regardless of your user 
level and experience, you will be navigating the new interface smoothly in no time.  It’s a practice makes 
perfect scenario, and one of the best ways to figure out the new apps, is just to dive into them and look 
around. 

 

Welcome to The Ribbon 
The first thing you notice is that the old menus and tool bars are gone.  In their place we have ‘The 
Ribbon’ which is a hybrid of the two as show in the picture below.  Where you use to see menu names, 
you see names on tabs.  These tabs are task oriented. 

 

 

The Home Tab is highlighted, in the example, and shows the most commonly accessed Word features in 
Groupings (e.g. Clipboard, Font, Paragraph, etc).  Grouping of items in each tab divides the task into 
subtasks.  

O 

Tabs 

Groupings 



Page 4 of 9 

 

 

As for the tabs themselves, there are some tabs that will appear when you work with an object that you 
select on the page, such as a table, picture, or drawing. When you click the object, a new tab appears in 
an accent color next to the standard tabs.  Not all tabs in the ribbon will always be available for use.  
Some will only appear when you select an event that produces the tab to appear. 

 

 

 

Command buttons allow for quick access to tasks.  If you place your mouse pointer and hover over a 
command button it will tell you what it is and what it will do.   

You will notice a significant use of dialog boxes in the new Office 
applications.  This has been done by request and design.  However if you 
need to launch a dialog box look for a small gray box at the bottom of a 

group of commands: .  This will launch a dialog box for that group (e.g. 
Clipboard, Font, Paragraph, Styles, etc.).   

These dialog boxes are similar to the ones that you may be used to 
accessing from the older versions of Office Applications. 

 

The Office Button 

The Office button   is another very prominent feature of the Office 
2007 applications.  It is here that you will find those commands that used 
to live in the File menu in previous versions ― file tasks such as Print, New, 
Open, Save and Send.  In addition to these commands, the application 
options that used to be contained in the Tools menu in previous versions 
are also accessible at the bottom of the Office button dialog ― Word 
Options.  The Word Options themselves have a new look and feel for each 
of the applications.  Recent Documents visible to the right of the 
commands, list word documents that are open as well as those you 
recently opened. 

Command Buttons Dialog Box Launchers 

Office Button 
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The Quick Access Toolbar 
The Quick Access Toolbar is the toolbar located above 
the ribbon and to the right of the Office button.  It is 
here that you will have quick access to commands such 
as Save, Undo, and Print (to your default printer).  

Commands that are located on this toolbar can be traded for other 
commands, as you desire.  To change, or customize the Quick Access Toolbar, 
click the down arrow at the end of the toolbar and click on the button that 
you wish to add.   

You also have options to reposition the position of the toolbar, depending on 
your user preference and to minimize the ribbon whenever you may need to. 

 

Live Preview 
Have you ever paused with your mouse over a command or a formatting option and wondered what it 
would do to your document?  Those days are over.  Live Preview is a new feature in Word 2007.  Now 
you can hold your mouse over a formatting style, Building Block, or color and you will see a preview 
right within your document.  If you like what you see in the preview, click your mouse button and the 
changes take effect on your document.  If you don’t like what you see then just move your mouse away 
from that button or menu option and your document snaps back to its previous appearance. 

 

Building Blocks 
Word 2007 has created Building Blocks to save you time and stress.  Building Blocks are reusable pieces 
of content or other document parts stored in galleries that you can easily drop into your document to 
make it look good and professional.  Microsoft has thrown in dozens of headers, footers, tables of 
contents, fax cover pages, and more.  

You can use AutoText, one type of building block, to store text or graphics that you want to use again, 

such as a standard contract clause or a long distribution list. Each selection of text or graphics is stored 

as an AutoText entry in the Building Blocks Organizer and is assigned a unique name that makes it easy 

for you to find the content when you want to use it. 

 

More Art Features 
Word 2007 has included more clip art; more charts and graphs; and more lines, shapes and arrows.  
They even included a new type of artwork called SmartArt developed for 
business presentations.  SmartArt makes it easy for you to create flow charts, 
organizational charts, and other graphics that combine words and pictures.  
You provide the words, and SmartArt takes care of all the sizing and 
formatting. 
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Updated Spelling and Grammar Features 
Microsoft has updated these features to be global across Office applications.  This simply means that if 
you update your spelling or grammar options in one office program, the option will update in all of the 
Office programs.  This feature is also true of the custom words that you add to the dictionary, it will be 
added globally, or for all Office applications.  This will save you time from having to make the same 
corrections in Word and then in Excel, and then in PowerPoint. 

In addition to this, Office also allows you to add words to an exclusion dictionary.  This feature allows 
you to flag words that you want to avoid using in your documents and files.   

One of the most asked questions I always received about the Spelling and Grammar checks was the way 
the applications allowed for the wrong word to be used in context, simply because it was spelled 
correctly.  Office 2007 provides support for Contextual Spelling.  Meaning that if you insert the word 
“their” in a place you should have contextually placed the word “there,” it should be flagged as a 
spelling mistake. 

 

Convert your Documents to PDF or XPS 
Office Word 2007 supports exporting your file to the following formats: 

 Portable Document Format (PDF)  PDF is a fixed-layout electronic file format that preserves 
document formatting and enables file sharing. The PDF format ensures that when the file is 
viewed online or printed, it retains exactly the format that you intended, and that data in the file 
cannot be easily changed. The PDF format is also useful for documents that will be reproduced 
by using commercial printing methods.  

 

Instantly Detect Documents that Contain Embedded Macros 
Office Word 2007 uses a separate file format (.docm) for macro-enabled documents, so you can 
instantly tell whether a file is capable of running any embedded macros.  This feature allows for you, as 
a receiver of a document, to be able to quick identify a document that have embedded code.  This 
becomes a security precaution, because macros and hidden codes may contain viruses or other malware 
that is unwanted.  Do not open documents or email attachments with macros, unless you expect the 
document to have macros in the document. 

 

Using Help 
Help with Word 2007 is never far away.  The most convenient place to look for help is Word’s built-in 

Help System.  Press the F1 key or click on the round button with a question mark  in the upper right 
hand corner.  
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The Word Help box opens in its own window, so it’s not hard to drag it out of the way or to minimize it.  
You have two methods for locating information when using Help.  You 
can use the Search Text box where you can enter a word or sentence of 
what you are searching for.  Or you can use the Table of Contents and 
drill down through topics until you find the information you need.  Use 
the Help feature to locate old features or functions you were used to so 
you can better navigate your way through Word 2007. 

 

 

 Save a Template in the My Templates Folder 
A commonly used feature in Office is the creation of custom, personal 
templates in Word or Excel.  Office 2007 will prompt you to save them 
in a new default location, and they will be available for future use.  The location will depend on the 
operating system that your machine is using, either Windows XP or Windows Vista.  As of the 
publication date of this manual, all users are on Windows XP, with no immediate plans to upgrade to 
Windows Vista. 

1. Click the Microsoft Office Button , and then click Save As.  

2. In the Save As dialog box, click Trusted Templates (Microsoft Windows XP) or Templates 
(Windows Vista).  

3. In the Save as type list, select Word (or appropriate application) Template.  

Type a name for the template in the File name box, and then click Save 

 

Office Diagnostics 
Microsoft Office Diagnostics is a series of diagnostic tests that can help you to discover why your 
computer is crashing. The diagnostic tests can solve some problems directly and may identify ways that 
you can solve other problems. Microsoft Office Diagnostics replaces the following Microsoft Office 2003 
features: Detect and Repair, and Microsoft Office Application Recovery. 

Help 
Button 
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File This Away 
Office 2007 has a new file format, for Word documents (.docx); Excel documents (.xlsx) and PowerPoint 
presentations (.pptx).  The file format is the way a program writes information to a computer disc or 
folder on a drive.  This new file format makes it safer for our computers against computer viruses.  The 
downside of this new file format is that you can’t open the new documents with older versions of Word 
or Office computer programs.  The best thing is to make sure you save your documents using ‘Save As’ 
then selecting the file type: Word 97-2003 (*.doc) so that your document can open within the older 
program versions.  This is especially useful when emailing your document to another user and their 
computer is not yet upgraded to Office 2007. 

 

Program Recovery 
Office has improved capabilities to help avoid losing work when the program closes abnormally. 
Whenever possible, Office tries to recover some aspects of the state of the program after Word restarts. 

For example, you are working on several files at the same time. + Each file is open in a different window 
with specific data visible in each window. Word crashes. When you restart Word, it opens the files and 
restores the windows to the way they were before Word crashed. 

This has been a general overview of Office applications, and how they have changed in Office 2007 
compared to earlier versions.  More specific instruction for each application is available in several 
different levels.  In addition to this information, the following Appendix will list the changes in the 
Shortcut keys that you may be familiar with using.  Although Office 2007 will recognize most of the old 
commands, you will benefit by transferring to the new commands, as the older ones will become 
deprecated in the future.  If you have questions or need further support please feel free to contact the 
Administrative Office of the Courts Technical Help Desk, or Technical Trainer for further instruction.  The 
contact phone number to these resources is (800) 448-7980 extension 214 or (615) 741-2687.



Page 9 of 9 

 

 

Appendix 
To do this Press 

Select the active tab of the Ribbon and activate the 
access keys.** 

ALT or F10. Press either of these keys again to move back to the document and 
cancel the access keys.** 

Move to another tab of the Ribbon. ALT or F10 to select the active tab, and then LEFT ARROW or RIGHT ARROW 

Minimize or restore the Ribbon. CTRL+F1 

Display the shortcut menu for the selected 
command. 

SHIFT+F10 

 

Keyboard shortcuts  
All old shortcut keys that start with CTRL are retained. So are the function keys. 

**New shortcut keys that start with ALT are clearly indicated on the screen. Just press and hold the ALT 
key and Office shows the letter for each tab, group, and command. 
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